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1 Memory and Storage Devices Computer-1 

2 Computer-1

A.    Tick ( ) the correct option.
Ans.  1.  (a) Ruler

   2.  (c) smart

   3.  (b) easier

   4.  (c)               Television

B.   Look at the pictures carefully. Fill the box with green if it is not a 
machine and red if it is a machine:

Ans.

C.   Match the following:
1.    It washed the clothes.   (iii)

2.   It is used to store food and drinks.   (v)

3.   It runs on fuel.     (ii)

4.   It is a smart machine.   (i)

5.   It is used to cut papers.   (iv)

D.   Answer the following questions:
Ans.  1.   A machine is a tool that makes our work easier and faster.
   2.  Television and Washing machine.
   3.  Car and Aeroplane.
   4.  Because it works fast, saves our work, does many tasks, and never 

gets tired.

Machine Machine

Machine MachineNot machine

Not machine



2 Computer Components
A.    Tick ( ) the correct option.
Ans.  1.  (c) Six
   2.  (b) easier
   3.  (a) CPU
    4.  (c) Speakers
   5.  (b) It displays the pictures
B.   Read the given clues and complete the name of the parts of the 

computer:
Ans.  1.

   2.

   3.  

C.   Write one use for each given part of the computer:
Ans.  1.  It shows pictures and videos.
   2.  It helps to click and select items.
   3.  They help us to listen to sound/music.
   4.  It is used for typing.
   5.  It prints documents (hard copy).
   6.  They help us listen to sound privately.
D.   Write the missing words using the given list as reference:
Ans.  1.  Monitor
   2.  Keyboard
   3.  CPU
   4.  Speakers
   5.  buttons.

K E Y B O A R D

M O N I T E R
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3 Keyboard and Mouse
A.    Tick ( ) the correct option.
Ans.  1.  (b) A–Z
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   2.  (a) 104
   3.  (c) 3
    4.  (a) Backspace Key
B.   Match the keys with their correct names:
1.        i) Delete Key  2.

        ii) Alphabet Key

3.        iii) Backspace Key  4.

        iv) Caps Lock Key

5.        v) Number Key  6.

        vi) Escape Key

C.    Answer the following questions:
Ans.  1.  Spacebar is the longest key on the keyboard.
   2.  Caps Lock key is used to type capital letters.
   3.  The keyboard is rectangular in shape.
   4.  A mouse is an input device used to draw pictures, click icons, and 

open items on themonitor.
   5.  A mouse usually has two or three buttons.

4 Starting and Shutting Down Computer
A.    Tick ( ) the correct option.
Ans.  1.  (c) icons
   2.  (a) power source
   3.  (b) life span
B.   Write the steps to shut down the computer in your notebook.
Ans.  S tep 1 - Click on the Start button.
   Step 2 - Click on the Power option.
   Step 3 - Click on Shut down.
C.    In the following images, the girl is turning on the computer. Arrange 

the picture in the correct order:
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Ans.  S tep 1 - Switch ON the power supply.  S tep 2 - Switch ON the UPS.

   Step 3 - Switch ON the power button  Step 4 - Switch ON the monitor.
       on the CPU cabinet.   

5 Entering Text in Notepad
A.    Tick ( ) the correct option.
Ans.  1.   (c) both a) & b)
   2.  (a) Title bar
   3.  (b) .txt
   4.  (c) Print button
B.   B. Tick ( ) the correct and cross ( ) the wrong statements:
Ans.   1.  ( )
   2.  ( )
   3.  ( )
   4.  ( )
C.    Answer the following questions:
   1.  Notepad is used to type and edit simple text documents.
   2.  Title Bar, Menu Bar, Working Area, Status Bar
   2.  Yes, we can change the font size in Notepad.
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6 Computer-1

6 Paint on Paint
A.    Tick ( ) the correct option.
Ans.  1.  (b) 2
   2.  (b) View
   3.  (c) Save
B.   B. Tick ( ) the correct and cross ( ) the wrong statements:
1.        (i) Brushes    2.

        (ii) Text

3.        (iii) Fill with Color  4.

        (iv) Pencil

5.        (v) Magnifier   6.

        (vi) Eraser

C.    Write the uses of the following tools:
Ans.  1.  It is used to type text directly onto a picture.
   2.  It is used to apply colour using strokes as you move the cursor.
   3.  It is used to draw a line with different colours.
D.    Answer the following questions:
Ans.  1.  Yes, we can colour pictures in MS Paint using the Fill with Color tool.
   2.  File tab and View tab.
   3.  Circle (Oval), Square, Rectangle, Triangle, Star, Arrow.

7 Tux Paint
A.    Tick ( ) the correct option.
Ans.  1.  (a) sound effects
   2.  (b) Color Box
   3.  (c) white
   4.  (a) New Tool
B.   Tick ( ) the correct and cross ( ) the wrong statements:



7 Computer-1

Ans.   1.  ( )
   2.  ( )
   3.  ( )
C.   Write any two features of Tux paint in your notebook.
Ans.     Tux Paint is a free software.
    Funny sound effects are played when we select any tool in Tux Paint.

8 Learn Patterns
A.    Fill in the blanks:
Ans.  1.  Do it yourself.
   2.  (Your age + 1)
   3.  7, 5
   4.  5 

9 Introducing AI
A.    Tick ( ) the correct option.

Ans.  1.  (c) human

   2.  (a) Artificial

   3.  (a)               AutoDraw (pencil icon)

B.     Write the missing words using the given list as reference:
Ans.  1.  AI (Artificial Intelligence)
   2.  brain
   3.  robot
C.    Answer the following questions:
Ans.  1.  Artificial Intelligence (AI) allows a computer to think and learn.
   2.  Smartphone and Smart Watch.
   3.  AutoDraw is the modern drawing tool that changes rough sketches 

into inventivesymbols.



A.  Tick ( ) the correct option. 
Ans 1 (c)  trillion
  2 (c)  both a) & b)
  3 (a)  Supercomputer
  4 (b)  output
B.  Identify and name the pictures.
Ans. 1 Supercomputer
  2 Mainframe Computer
  3 Personal Computer (PC)
  4 Minicomputer
C.  Answer the following questions.
Ans. 1 There are five types of computers.
  2 The Supercomputer is the largest in size.
  3 PC is a general-purpose computer used for personal work like typing, 

watching movies, etc.
  4 A workstation is used for technical and scientific work like animation, 

data analysis, and video editing.
  5  It accepts input from the user.
   It gives output/results after processing.

1 Memory and Storage Devices Computer-2

8 Computer-2

A.  Tick ( ) the correct option. 
Ans 1 (b) airports
  2 (a) Banks
  3 (b) diagnose diseases
B.  Fill in the blanks
Ans. 1 watch
  2 music
  3 sums
  4 send

2 Uses of Computer



C.  Tick ( ) and Cross ( ) the wrong statement.
  1 

2 
3 
4 

D.  Answer the following questions.
Ans 1 Computers are crucial because they help us do many tasks quickly and 

save time.
Ans 2 We can watch movies, listen to music, solve sums, type documents, send 

emails, and play games.
Ans 3 Yes, we can send e-mails through a computer.
Ans 4 Doctors use computers to diagnose diseases.

A.  Tick ( ) the correct option. 
Ans 1 (b) 6
  2 (b) CPU
  3 (c) Scanner
B.  Match the following
   Column A Column B
Ans. 1. CPU (iv) Processing Device
  2. Keyboard (i) Input Device
  3. Pen Drive (iii) Storage Device
  4. Monitor (ii) Output Device
C.  Fill in the blanks.
  1 enter
  2 input, output
  3 data
  4 programs
D.  Answer the following questions.
Ans. 1 Peripherals are devices used to input data into or get data from a 

computer.
  2 I/O devices are Input and Output devices that help the computer to take 

input and give output.

3 Accessories for Computers
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  3 Hardware are physical parts of a computer (like keyboard, mouse).
   Software are programs that run on a computer (like Paint, MS Word).
  4 Keyboard, Mouse
  5 Monitor, Printer

A.  Tick ( ) the correct option. 
Ans 1 (b) drawing tool
  2 (a) Title bar
  3 (a) 6
  4 (c) Minimize button
  5 (c) Pick Color
C.  Tick ( ) and Cross ( ) the wrong statement.
Ans 1 

2
3
4

D.  Answer the following questions.
Ans 1 The Paint program is used for drawing pictures. It helps us to make 

simple as well as complex drawings on the computer.
  2 1. Pencil Tool                       2. Eraser Tool                       3. Fill with Color Tool            
   4. Text Tool                           5. Pick Color Tool
  3 The Text tool is used to insert text into a picture.
  4 A drawing in Paint is saved as a bitmap (BMP) file.

4 About Paint

A.  Tick ( ) the correct option. 
Ans 1 (c) Both a & b
   (c) 140
   (a) Drawing Area
   (a) Stamp tool

5 Paint with Tux Paint
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B.  Fill in the blanks.
Ans. 1 free
  2 mascot
  3 Color Box
  4 Quit
C.  Match the following tools with their names.

     i)  Shapes

     ii) Stamp

     iii) Fill

     iv) Quit

     v) Text

     vi) Magic

D.  Answer the following questions.
Ans. 1 Ease of use and entertainment
   Simplicity
  2 The Magic tool is used to add special effects like blur, mirror, rain, etc., to 

drawings.
  3 You can select the size of the eraser from the selector panel on the right 

side.
  4 From the selector/sub-toolbar of the Text tool.

A.  Tick ( ) the correct option. 
Ans 1 (a) Ribbon
   (b) Right side
   (b) Right side
   (c) U
B.  Fill in the blanks.
Ans. 1 WordPad

6 Work on WordPad
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  2 Title
  3 right
  4 two
  5 printer
C.  Tick ( ) and Cross ( ) the wrong statement.
Ans 1 

2
3
4

D.  Answer the following questions.
Ans. 1 WordPad is a Windows application used to create, edit and format 

documents like letters, notes and posters.
  2 It is an easy tool for doing simple tasks.
   It helps in formatting and printing documents.
  3 Yes, we can use WordPad to create letters and documents.
  4 Title Bar
   Ribbon
   File Menu
   Document Area
  5 Alignment is the way text is arranged on a page.
   Main alignments are: Left alignment,  Right alignment,  Center alignment,  

Justify alignment

A.  Tick ( ) the correct option. 
Ans 1 (a) Pattern
   (b) Repeating pattern
   (b) Decoding
B.  Fill in the blanks.
Ans 1 region
  2 decomposition
  3 coding
C.  Answer the following questions.

7 Think with Pattern
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  1 Repeating pattern
   Growing pattern
   Shape pattern
  2 Decomposition means breaking a big problem into smaller parts to 

make it easier to understand and solve.
  3 Decoding is the process of converting a coded message back into its 

original meaning.

A.  Tick ( ) the correct option. 
Ans 1 (c) both a & b 
   (a) Stage
   (b) Script
B.  Tick ( ) and Cross ( ) the wrong statement.
Ans 1 

2
3
4

C.  Answer the following questions.
Ans. 1 A Sprite is a character or object in Scratch that performs actions in a 

project.
  2 The programming palette is the area that contains blocks used to create 

programs for sprites.
  3 The green flag is used to start or run the program.
  4 It is important to save a document so that your work is not lost.
   Steps to save:
   1.  Click on File
   2.  Click on Save
   3.  Give a name to the project
   4.  Click on Save

8 Introduction to Scratch 3.0

A.  Tick ( ) the correct option. 
Ans 1 (b) computer

9 Artificial Intelligence
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  2 (c) Cortana
  3 (a) 1956
  4 (c) Both a & b
  5 (c) Scientific Discovery
B.  Write the missing words using the given list as reference. 
Ans. 1 Artificial Intelligence (AI)
  2 algorithms
  3 robots
  4 Machine learning
  5 thermostats
C.  Answer the following questions.
Ans. 1 It helps in solving difficult problems easily.
   It improves handling of information.
  2 Gaming,   Education,   Healthcare,   Finance,   Automobiles
  3 Machine Learning is a part of Artificial Intelligence that allows computers 

to learn from data and improve their performance without being directly 
programmed.

  4 AI-enabled refrigerators use barcode or RFID tracking.
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1 Components of Computer Computer-3
A.  Tick ( ) the correct option.
Ans. 1.  a)  Input
 2.  c)  Digitizing Tablet
 3.  c)  Both a) & b)
 4.  b)  ALU
B.  Write the full form of the following.
Ans. 1.  ALU -  Arithmetic Logic Unit
 2.  CU  - Control Unit
 3.  CPU  - Central Processing Unit
 4.  VDU  - Video Display Unit
 5.  LCD - Liquid Crystal Display
 6.  CRT -  Cathode Ray Tube
C.  Tick ( ) the correct and cross ( ) the wrong statements.
Ans. 1. 
 2. 
 3. 
 4. 
D.  Answer the following questions.
Ans. 1. A computer has four main parts:
 
 
 
 
 2.    Type       Description        Examples
  Input Devices - Used to enter data into the - Keyboard, Mouse
       computer   
  Processing Device- Processes the data - CPU
  Output Devices - Show results from the 
       computer - Monitor, Printer



3.  
 
   
   
   
4. Hard Copy:  Printed output on paper
 Soft Copy:   Output visible on screen
5. Storage devices are used to store data for future use.
 Examples:
 
 
  
 

2 Windows 11
A.  Tick ( ) the correct option.
Ans. 1.  c)  Windows 11
 2.  b)  Settings
 3.  c)  Alt + F4
B.  Write the missing words using the given list as reference:
Ans. 1.  by toggling
 2.  Task View
 3.  credentials
C.  Answer the following questions.
Ans. 1. Windows was first launched in 1985. 
 2. The redecessor of Windows 11 is  Windows 10.
 3. Some features of Windows 11 are:
  Mac-like interface (clean design)
  Widgets 
  Integrated Android apps
  Better multitasking (Snap Layouts)
  Better virtual desktop support
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 4. Widgets are small tools that show useful information like:
   Weather
   News
   Sports
   Calendar
  They are available on the taskbar and can be customized.
 5. Turn on the PC
  Click on the screen
  Enter your username and password (credentials)
  Click the arrow or press Enter
   You will reach the Desktop

3 Paint 3D
A.  Tick ( ) the correct option.
Ans. 1.  b)  Windows 11
 2.  a)  Save
 3.  c)  Both a) & b)
B.  Read the clues and name the tools present in Paint 3D:
Ans. 1.  Brushes Tool
 2.  Options Tool
 3.  2D Shapes Tool
 4. 3D Shapes Tool
C.  Answer the following questions.
Ans. 1. 
  It allows creating .
  It includes 
  It can convert . 
 2. 
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  (You can also write: Options Tool, Canvas, Color Palette)
 3. 1.  Select the 3D Shapes tool
  2.  Choose a shape (like cube)
  3.  Move the mouse to canvas
  4.  Drag to draw the shape
  5.  Adjust or rotate the shape
 4. Paint 3D is better because it allows creating 3D objects, has more tools, 
  effects, and features, and helps turn drawings into 3D models.

4 MS Word 2019
A.  Tick ( ) the correct option.
Ans. 1.  a)  Microsoft Office Suite

 2.  b)  right end

 3.  c)  Ribbon

 4.  b)  Home Tab

B.  Write the missing words using the given list as reference:
Ans. 1.  Learning Tools

 2.  Zoom Slider

 3.  Ribbon Display Options

 4. Save As, Save

C.  Answer the following questions.
Ans. 1. Word 2019 is a word processing application in Microsoft Office.
  It is used to create, edit, format, and print documents like letters,
   projects, and reports.

 2. 1.  Click on the Start button
  2.  Click on All Apps
  3.  Scroll and find Word 2019
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  4.  Click on it to open

 3. Active Tab:
  It is the tab that is currently open (by default Home tab).

  Contextual Tab:
  It appears only when you select objects like pictures or text boxes and
  shows extra options.

 4. Saving files is important because it stores your work permanently and
   allows you to open and use it later without losing data.

5 Internet Worldwide
A.  Tick ( ) the correct option.
Ans. 1.  c)  Both a) & b)
 2.  b)  Internet
 3.  a)  E-mail
 4.  c)  Both a) & b)
B.  Write the full form of the following.
Ans. 1.  WWW :  World Wide Web
 2.  ISP  :  Internet Service Provider
 3.  URL  :  Uniform Resource Locator
 4.  SDG  :  Sustainable Development Goals
C.  Write the differences between the following:
Ans. 1. Home Page vs Web Page
  Home Page  Web Page
  First page of a website Any page of a website
  Gives introduction and links Contains information
  Main starting point Can be any internal page
 2. Web Browser vs Search Engine
  Web Browser Search Engine
  Software to open websites Tool to search information
  Example: Chrome, Edge Example: Google, Yahoo
  Displays web pages Finds websites
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D.  Answer the following questions.
Ans. 1. The Internet is a global network of interconnected computers that
   allows people to share information and communicate worldwide.
 2. Because it helps in communication, learning, shopping, banking,
  entertainment, and accessing information quickly.
 3. Searching information easily
  Online communication
  Entertainment
  Online shopping and banking
 4. A computer
  Modem or data connection
  Web browser
  ISP account
 5. 1. Click on Start button
  2. Click on All Apps
  3. Scroll and select a browser (like Chrome)
  5. Click to open

6 Algorithm
A.  Tick ( ) the correct option.
Ans. 1.  c)  solving a problem
 2.  a)  Logical sequence
 3.  b)  When the problem is solved
B.  Write the missing words using the given list as reference:
Ans. 1.  programmers
 2.  programming
 3.  flowcharting
 4.  display
C.  Tick ( ) the correct and cross ( ) the wrong statements.
Ans. 1. 
 2. 
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 3. 
D.  Answer the following questions.
Ans. 1. An algorithm is a step-by-step procedure or set of instructions used to
  solve a problem. 
 2.
   Each step is clear and well-definedIt
   produces an output
  It follows a logical sequence
  It is simple and effective
 3. A flowchart is used to represent an algorithm in a diagram form
  using symbols. It helps to understand the process easily.
 4. Start/End symbol shows the beginning or ending of a process
  Process symbol shows calculations or steps
  Input/Output symbol shows data input or output
 5. Algorithm    Flowchart
  Written in steps    Drawn using symbols
  Uses plain text    Uses shapes
  Harder to understand  Easy to understand
  Easy to debug    Hard to debug

7 More on Scratch 3.0
A.  Tick ( ) the correct option.
Ans. 1.  c) both a & b

 2.  c) Blocks

 3.  c) 8
B.  Tick ( ) the correct and cross ( ) the wrong statements.
Ans. 1. 
 2. 
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D.  Answer the following questions.
Ans. 1. Scratch 3.0 is used to create interactive stories, games and animations
   using block-based coding.
 2. Scratch was created by the MIT Media Lab.
 3.  Easy to use (no typing commands)
  Drag and drop blocks
  Colour-coded commands
  Helps in creating games and animations easily
 4. Where actions and animations happen
  Character or object in the program
  Where blocks are joined to create code
   Contains coding blocks

8 World of AI
A.  Tick ( ) the correct option.
Ans. 1.  a)  Humans
 2.  a)  breaks
 3.  b)  Sophia
 4. c)  Saudi Arabia
 5. a)  sets of instructions
B.  Write the missing words using the given list as reference:
Ans. 1.  Artificial Intelligence
 2.  based on data and algorithms
 3.  accuracy and precision
 4.  humanoid
C.  Answer the following questions.
Ans. 1. Artificial Intelligence (AI) is the ability of a computer or machine to
  think, learn and make decisions like humans.
 2. A set of instructions (programs) helps AI to analyze data, make
  decisions and perform tasks automatically.
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 3. Programs like Siri, Google Assistant and Cortana use smart
  technology to recognize speech and respond.
 4. Reduces human errors
  Works 24×7 without breaks
  Helps in faster decisions
   Provides digital assistance
 5. (a) Al and Human Intelligence
  
  
  
  (b) Weak Al and Strong Al
   Weak Al performs specific tasks; Strong Al can think and act like 
   humans
   Weak Al is limited; Strong Al is advanced
   Examples: Alexa (Weak Al), Sophia (Strong Al)
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1 Advanced Power Point 2016 Computer-6 

2 Computer-6

A.    Tick ( ) the correct option.
Ans.  1.  (c) .asf
   2.  (a) Play in the Slides
   3.  (b) .wma
   4.  (c) Windows 10
   5.  (a) Print All Presentations
B.    Fill in the blanks.
Ans.  1.  Audio on My PC
   2.  Record
   3.  Media, Insert
   4.  Action
C.    Write ‘T’ for true and ‘F’ for false statements.
Ans.  1.  False
   2.  False
   3.  False
   4.  False
D.    Short answer type questions.
Ans.  1.   All slides of the presentation will be printed.
   2.  Action buttons are built-in shapes in Power Point that can be used to
     perform actions like opening a web page, an e-mail, a linked file, or
     another slide when clicked.
   3.  Full Page Slides and Print Current Slide.
E.    Long answer type questions.
Ans.  1.  Step 1 – Select a slide. 
     Step 2 – Click on the Insert tab. 
     Step 3 – Click on Shapes command toopen the drop-down list. 
      Step 4 – Choose an Action Button shape from the bottom of the gallery.
      Step5  –  Click and drag the mouse pointer on the slide to draw the button. 
     Step 6 – The Action Settingsdialog box opens. 
     Step 7 – Click OK to create the action button.
   2.   Step 1 –  Click on Video command under the Media group of the Insert tab. 
     Step 2 – SelectOnline Video option from the drop-down menu. 



2 Introduction to Animate CC

     Step 3 – Paste the URL of the video in the OnlineVideo dialog box. 
     Step 4 – Click Insert. The video thumbnail appears in the slide and
     plays directlyfrom the website during the slide show.

A.    Tick ( ) the correct option.
Ans.  1.   (a) Tool panel
   2.   (a) Line 
   3.   (d) .fla 
   4.   (c) Eraser 
B.    Fill in the blanks.
Ans.  1.   lines/strokes.
   2.   Web/Internet 
   3.   timeline.
   4.   Instance
   5.   Lasso
C.    Write ‘T’ for true and ‘F’ for false statements.
Ans.  1.   True
   2.   False
   3.   False
   4.    True
D.    Short answer type questions.
Ans.  1.   Adobe Animate CC is a software developed by Adobe Systems used
      to create animations and vector graphics for websites, videos, games 

and applications.
   2.   The Properties Panel (Property Inspector) is used to view and change 

the properties of a selected object. It allows us to modify settings 
like size, colour, position, etc.

   3.   Gradient fill is a type of fill where one colour gradually changes into 
another colour inside a shape.

   4.   There are three types of symbols: Movie Clip Symbol (for 
animations), Button Clip Symbol (for interactivity), and Graphic 
Symbol (for building complex movie clips).

E.    Long answer type questions.
3 Computer-6



Ans.  1.    Step 1 – Click File → Open and select the file. 
      Step 2 – Select Rectangle Tool from the Toolspanel. 

 Step 3 – Set Stroke Color and Fill Color in Properties panel. 
      Step 4 – Click Object Drawing mode in Tools panel. 
      Step 5 – Draw a rectangle on the stage. 
      Step 6 – Click Selection Tool. 
      Step 7 – Click the rectangle and go to Modify → Convert to Symbol. 
      Step 8 – In the Convert to Symbol dialogbox, enter a name and click   

OK. The symbol is listed in the Library panel.
   2.    (i) Lasso - Used to select objects or parts of objects in free-form shape.
      (ii) Eyedropper - Used to pick colour or style from one object and 

apply it to another.
      (iii) Sub Selection - Used to select and modify specific anchor points 

in lines or curves.

3 Introduction to HTML 5
A.    Tick ( ) the correct option.
Ans.  1.  (c) <hr>
   2.   (c) You cannot define your own attributes in HTML5
   3.   (c) <!--comment-->
   4.  (c) Body tag
B.    Fill in the blanks.
Ans.  1.  Markup
   2.  website
   3.  web browser
   4.  graphics
   5.  .html / .htm
C.    Write ‘T’ for true and ‘F’ for false statements.
Ans.  1.  False
   2.  False
   3.  True
   4.  True
   5.  False
D.    Short answer type questions.

4 Computer-6
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Ans.  1.  A tag is a basic formatting tool of HTML used to tell the browser how 
to display content.

   2.  A website is a collection of related web pages linked together 
through hyperlinks.

   3.  An attribute is extra information added inside the opening tag to 
define properties of an element.

   4.  HTML stands for Hyper Text Markup Language.
E.    Long answer type questions.
Ans.  1.  Two tools are required: 
     (1) A Text Editor like Notepad or WordPad to write HTML code, OR a 

WYSIWYG Editor like Adobe Dreamweaver. 
     (2) A Web Browser like Google Chrome, Internet Explorer, or Mozilla 

Firefox to view and display the HTML file.
   2.   An HTML document is always enclosed within <html> and </html> 

tags. It has two sections: 
     (a) Head Section – contains <head> and <title> tags; the title is 

shown in the browser's title bar. 
     (b) Body Section – contains <body> tag; holds all content shown on 

the web page like text, images, and videos.
   3.   (1) Container Tags – Tags that have both an opening and a closing 

tag, e.g., <html>...</html>, <body>...</body>. 
     (2) Empty Tags – Tags that do not have a closing tag, e.g., <br>, 

<hr>. These are also called self-closing tags.

4 MS Excel : Working with Data
A.    Tick ( ) the correct option.
Ans.  1.  (b) double-clicking
   2.  (c) 255
   3.  (d) All of these
   4.  (c) Worksheet
B.    Fill in the blanks.
Ans.  1.  row
   2.  Cell Styles
   3.  operators.
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   4.  Insert
   5.  Merge & Center
C.    Write ‘T’ for true and ‘F’ for false statements.
Ans.  1.  True
   2.  False
   3.  True
   4.  True
   5.  False
D.    Short answer type questions.
Ans.  1.  Unmerge Cells command (found by clicking the arrow next to Merge 

& Center in the Alignment group on the Home tab).
   2.  We need to select cells before performing operations like modifying, 

copying, moving, deleting, or formatting data in Excel.
   3.  The Copy command copies the selected cell's content and 

formatting to the clipboard, so it can be pasted at another location 
without removing it from its original place.

E.    Long answer type questions.
Ans.  1.  Method 1 – Using Fill Handle: Select the cell with the formula. 

Position the mouse pointer at the lower-right corner until a black cross 
(+) appears. Drag it to the cells where you want to copy the formula. 

     Method 2 – Using Copy-Paste: Select the cell, press Ctrl+C to copy, 
select the destination cells, and press Ctrl+V to paste.

   2.  Step 1 – Select the row(s) or column(s) to change. 
     Step 2 – Click Format command in the Cells group on Home tab. 
     Step 3 – Choose Row Height or Column Width under Cell Size. 
     Step 4 – Type the desired value and click OK. Alternatively, double-

click the boundary between two row/column headings to auto-fit 
the content.

   3.   Text wrapping allows displaying multiple lines of text inside a single 
cell without affecting othercells. Steps: 

     Step 1 – Click on the cell where you want to wrap the text. 
     Step 2 – Click on Wrap Textcommand from the Alignment group 

under the Home tab. The text will now wrap within the cell.



5 MS Excel : Formulas and Functions
A.    Tick ( ) the correct option.
Ans.  1.  (b) cell reference
   2.  (c) cell range
   3.  (d) SQRT()
   4.  (a) Average
   5.  (a) A3
B.    Fill in the blanks.
Ans.  1.  label
   2.  Function
   3.  MIN
   4.  equal
   5.  TODAY
C.    Write ‘T’ for true and ‘F’ for false statements.
Ans.  1.  False
   2.  True
   3.  True
   4.  False
   5.  True
D.    Short answer type questions.
Ans.  1.  SUM() function adds all the values in a given range of cells. 
   2.  A label in Excel is a text entry used to describe or identify data in a 

worksheet.
   3.  A cell reference is a cell address that can be used in a formula to 

denote a specific cell.
E.    Long answer type questions.
Ans.  1.  Functions are predefined formulas in Excel. Categories: 
     Math functions (SUM, PRODUCT, SQRT), Text functions 

(CONCATENATE, LEFT, RIGHT, LEN, UPPER, LOWER), Logical functions 
(MAX, MIN, AVERAGE, IF), and Date & Time functions (TODAY, NOW, 
MONTH, YEAR, DAY, HOUR, MINUTE).

   2.   Cell reference is a cell address used in a formula. Types: 
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     (1) Relative Reference - changes when formula is copied, e.g., A1. 
     (2) Absolute Reference - does not change, uses $ sign, e.g., $A$1. 
     (3) Mixed Reference - partly fixed, e.g., $A1 or A$1.
   3.  LEN function returns the total number of characters in a text string. 

Example:  = LEN('Touch') givesoutput 5.
   4.  A group of selected cells is called a cell range. 
     Steps by mouse: 
     (1) Click on first cell. 
     (2) Hold left mouse button and drag diagonally. 
     (3) Release the mouse button - range is selected. 
     Steps by Shift key:
     (1) Click first cell. 
     (2) Hold Shift and click last cell. 
     (3) Release Shift - range is selected.

6 Computer Malware
A.    Tick ( ) the correct option.
Ans.  1.   (b) Computer
   2.   (c) Norton
   3.   (c) Dark avenger
   4.   (b) Firewall
   5.   (c) Fast processing speed
B.    Fill in the blanks.
Ans.  1.   Spam
   2.   Malware.
   3.   Antivirus
   4.   Resource
C.    Write ‘T’ for true and ‘F’ for false statements.
Ans.  1.   True
   2.   True
   3.   True
   4.    True
D.    Short answer type questions.



Ans.  1.   The different types of computer viruses are Program file virus, Boot 
sector virus, Macro virus, Multipartite virus, Polymorphic virus, and 
Stealth virus.

   2.   Malware is malicious software designed to damage, disrupt, or gain 
unauthorised access to a computer system.

   3.   Firewall is a security system that protects a computer from 
unauthorised access over a network.

E.    Long answer type questions.
Ans.  1.   ( i) Boot sector virus - A boot sector virus infects the master boot 

record of a hard disk. It loads into memory when the computer starts 
and spreads to other disks.

      (ii) Worms - Worms are malicious programs that replicate themselves 
and spread across networks without any human action. They slow 
down the network and computer.

      (iii) Trojan horse - A Trojan horse is a program that appears to be 
useful but is actually designed to steal and pass the user's personal 
information to others.

   2.   1. Real-time scanning: It repeatedly checks the computer system 
for the presence of malicious entities to restrict malware entry.

      2. Automatic updates: It frequently updates automatically to track 
and detect the latest emerging viruses.

      3. Protection for multiple apps: It is capable of scanning the entire 
system, including various apps and services installed on the computer.

      4. Fight against all types of malware: Good antivirus programs are 
designed to thoroughly detect and remove almost all specific types of 
malware.

   3.   Encryption is a technique used to convert plaintext (readable data) 
into an encoded version (ciphertext) using an encryption algorithm 
and a key. This ensures the safety of data during transmission over a 
network or Internet. The encrypted data cannot be decoded or read 
by anyone unless they have the correct decryption key. It is mainly 
used to protect sensitive information like passwords and banking 
credentials from unauthorised access.
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7 Algorithm and Flowchart
A.    Tick ( ) the correct option.
Ans.  1.  (c) six

   2.  (a) Flowchart

   3.  (a) Flowchart

   4.  (c)                          (parallelogram shape)

   5.  (a) Algorithm

B.    Fill in the blanks.
Ans.  1.  algorithm
   2.  vertical
   3.  flowchart.
   4.  Flow Lines
   5.  Loop
C.    Write ‘T’ for true and ‘F’ for false statements.
Ans.  1.  False
   2.  False
   3.  False
   4.  False
   5.  False
D.    Short answer type questions.
Ans.  1.  Algorithm is a step-by-step procedure of solving a logical or 

mathematical problem. It is always written in simple words and 
precise language.

   2.  A flowchart is a type of diagram that represents an algorithm or the 
process to solve a problem. It uses various symbols connected by 
flow lines.

   3.  The six basic symbols commonly used in a flowchart are Terminal 
(Start/Stop), Input/Output, Processing, Decision, Flow Lines, and 
Connectors.

   4.  1. Algorithm - An algorithm is a step-by-step text-based procedure 
written in simple language to solve a problem. 
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     2. Flowchart - A flowchart, on the other hand, is a graphical or 
diagrammatic representation of that algorithm using specific shapes 
and symbols.

E.    Long answer type questions.
Ans.  1.  1. Flow lines - Flow lines and connectors are both used in a 

flowchart but they serve different purposes. Flow lines show the 
direction of flow in a program and are used to connect the various 
symbols in a flowchart, showing the sequence in which steps are 
performed. They are represented by arrows.

     2. Connectors - Connectors, on the other hand, are circular symbols 
that are specifically used to connect breaks in the flowchart, 
meaning they join two separate parts of a flowchart when the chart 
is too long or needs to continue on another page or area.

   2.  The main characteristics of a good algorithm are:
     1. Definiteness: The steps are defined precisely.
     2. Input: It should have well-defined input.
     3. Output: It should have well-defined output.
     4. Finiteness: The steps required should be finite.
     5. Effectiveness: Each step must be able to be performed in a finite 

amount of time.
   3.  Terminal Symbol (Start/Stop box): It indicates the beginning and 

ending of a program in a flowchart.
     Input/Output Symbol (Parallelogram): It is used to indicate the 

input taken and the output shown by a program.
     Decision Symbol (Diamond): It is used to raise a question or a 

condition in a program that can have either Yes/No or True/False as 
an answer.

   4.  A decision making flowchart helps us to come to a decision on the 
basis of some logic. It uses at least one decision symbol (diamond 
box). The decision symbol has two exit points, one for Yes/True and 
another for No/False. It is used to check a certain condition and 
provide solutions based on whether the condition is met or not.
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8 Python – Introduction
A.    Tick ( ) the correct option.
Ans.  1.  (a) lower case
   2.  (b) Operators
   3.  (c) Exponential
   4.  (d) #
B.    Fill in the blanks.
Ans.  1.  Guido van Rossum.
   2.  Assignment
   3.  string
   4.  Input()
   5.  False
C.    Short answer type questions.
Ans.  1.  Variables are memory reference points where we store values which 

can be accessed or changed later.
   2.  IDLE stands for Integrated Development and Learning Environment.
   3.  Python was developed by Guido van Rossum. He started applying 

Python in 1989.
   4.  Identifiers are names given to variables, functions, or other objects in a 

Python program.
   5.  A data type specifies the type of value a variable can contain, such as 

integer, float, or string.
   6.  Operator precedence determines the order in which operators are 

executed in an expression. Highest to lowest: (), **, *, /, %, //, +, -, 
comparison, assignment, logical.

D.    Long answer type questions.
Ans.  1.  (i) Data type: Specifies the type of value a variable can hold (int, 

float, string, bool). 
      AND, OR, NOT — used to evaluate conditions. (ii) Logical operators:

(iii) Arithmetic operators: +, -, *, /, %, **, // — perform math 
operations. 

      Text ignored by interpreter, written with # (iv) Comment in Python:
for single line or triple quotes for multiline.

   2.   There are two types: 
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     Single-line comment — starts with #. (1) 
      Multi-line comment — enclosed in triple quotes (''' or """).(2)
   3.  (i) Keywords are reserved words in Python with special meaning (e.g., 

if, for, while), while Literals are fixed values written directly in the code 
(e.g., 5, 3.14, 'Hello').

      Single-line comment starts with # and covers only one line, while a (ii)
multi-line comment uses triple quotes (''' ''') and can span across 
multiple lines.

     (iii) AND operator returns True only if both conditions are true, while 
OR operator returns True if at least one condition is true.

   4.  Python has 6 relational operators: > (greater than: x>y), < (less than: 
x<y), == (equal: x==y), != (not equal: x!=y), >= (greater or equal: x>=y), 
<= (less or equal: x<=y). All return True or False.

9 Fields of Artificial Intelligence
A.    Tick ( ) the correct option.
Ans.  1.  (b) AGI
   2.  (c) Google
   3.  (a) chatbot
   4.  (a) machine
   5.  (a) Neural networks
B.    Fill in the blanks.
Ans.  1.  Artificial Narrow Intelligence (ANI)
   2.  AI (ANI)
   3.  strategic
   4.  obstacles
C.    Write ‘T’ for true and ‘F’ for false statements.
Ans.  1.  False
   2.  True
   3.  False
   4.  True
   5.  False
D.    Short answer type questions.
Ans.  1.  Artificial Intelligence is the process of simulating human intelligence 
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in man-made machines likecomputers, including learning, 
reasoning, and self-correction.

   2.  F.E.A.R. and Alien: Isolation use artificial intelligence.
   3.  ASI (Artificial Super Intelligence) refers to the ability of an AI system 

that could perform any task better than humans with cognitive 
behaviour.

   4.  Ethics in AI means the moral principles and rules that guide the fair, 
responsible and safe development and use of AI systems.

E.    Long answer type questions.
Ans.  1.  AI is important in: 
     (1) Gaming - generates intelligent opponents. 
      (2) E-commerce - recommends products. 
      (3) Banking - chatbots assist customers and prevent fraud. 
     (4) Robotics - robots sense obstacles. 
     (5) Healthcare - detects diseases early and suggests treatment.
   2.  AI in gaming improves strategic aspects of games. It generates 

responsive, adaptive and intelligent behaviour in non-player 
characters (NPCs) similar to human-like intelligence, presenting 
different scenarios and unpredictable opponents each time the user 
plays.

   3.  AI Ethics are moral guidelines for creating fair, safe and transparent 
AI systems. Organisations must ensure AI does not discriminate, 
respects privacy, is used for the benefit of all people, and is 
accountable for its decisions.


































































